COMPUTER SCIENCE
Computer Fundamentals

INSTRUCTIONS TO CANDIDATES

- Repeaters have to answer 90 questions only (Prior to 2011-12)
- Freshers have to answer 100 questions (2011-12 and onwards)

1. Immediately after the commencement of the Examination, you should check that this Booklet does not have any unprinted or torn or missing pages or items, etc. If any of the above defects is found, get it replaced by a Complete Question Booklet of the available series.

2. Write clearly the Question Booklet Version Code A, B, C, D or E, in the appropriate space provided for the purpose, in the OMR Answer Sheet.

3. Enter the name of the Subject, Reg. No., Question Booklet version code and affix Signature on the OMR sheet. As the answer sheets are designed to suit the Optical Mark Reader (O.M.R.) system, special care should be taken to fill those items accurately.

4. This Question Booklet contains 100 questions carrying equal marks. All questions must be attempted. Each question contains four answers, among them one correct answer should be selected and shade the corresponding option in the OMR sheet.

5. All the answers should be marked only on the OMR sheet provided and only with a black or blue ink ball point pen. If more than one circle is shaded / wrongly shaded / half shaded for a given question no marks will be awarded.

6. Immediately after the final bell indicating the closure of the examination, stop making any further markings in the OMR Answer Sheet. Be seated till the OMR Answer Sheet is collected. After handing over the OMR Answer Sheet to the Invigilator you may leave the examination hall.

P.T.O.
1. Who is the Father of the Computer?
   a) Herman Hollerith  
   b) Charles Babbage  
   c) Konrad Zuse  
   d) John Von Neumann

2. What does IBM stand for?
   a) International Bureau Machines  
   b) International Business Machines  
   c) International Billing Machines  
   d) International Banking Machines

3. Micro Computers are also known as
   a) Personal Computers  
   b) Mini Computers  
   c) Super Computers  
   d) Work Station

4. In second generation which component is used for internal operations
   a) Transistors  
   b) Vacuum tube  
   c) Punched cards  
   d) None of these

5. Which of the following is not the classification of computers based on application?
   a) Electronic Computers  
   b) Analog Computers  
   c) Digital Computers  
   d) Hybrid Computers

6. ENIAC stands for
   a) Electrical Numerator Internet Analog and Computer  
   b) Electrical Number of Internet Analog Computer  
   c) Electrical Numerator Internet Analyzer Computer  
   d) Electronic Numerator Integrator Analyzer and Computer

7. Each computer has a different binary coded program called
   a) Languages  
   b) Program  
   c) Machine Language  
   d) Program Languages

8. The electronic device that converts raw data into meaningful information is
   a) calculator  
   b) computer  
   c) printer  
   d) mouse
9. LSI stands for
   a) large scale integration  b) linear scale integration
   c) least scale integration  d) none of these

10. Palmtops also known as
    a) personal digital assistant  b) proper digital assistant
        c) post digital assistant  d) none of these

11. The computer that process both analog and digital is called
    a) Analog computer  b) Digital computer
        c) Hybrid computer  d) Mainframe computer

12. CAM stands for
    a) Camera Aiding Multimedia  b) Computer Answering Machine
        c) Computer Aided Manufacturing  d) None of these

13. Which statement is valid?
    a) 1 KB = 1024 bytes  b) 1 MB = 2048 bytes
        c) 1 MB = 1000 kilobytes  d) 1 KB = 1000 bytes

14. What is the binary equivalent of 44?
    a) 101100  b) 111000
        c) 101010  d) 101101

15. Addition of 10110 and 10101 is
    a) 101101  b) 101011
        c) 101010  d) 111000

16. Decimal equivalent of 1010 is
    a) 15  b) 12  c) 10  d) 8
17. MOUSE stands for
   a) Mechanical Operation Search Engine
   b) Mechanical User Search Engine
   c) Mechanical Operated User Search Engine
   d) Mechanical Opt Mechanical Engine

18. ALU is
   a) Arithmetic Logic Unit
   b) Array Logic Unit
   c) Application Logic Unit
   d) None of above

19. CD-ROM stands for
   a) Compactable Read Only Memory
   b) Compact Data Read Only Memory
   c) Compactable Disk Read Only Memory
   d) Compact Disk Read Only Memory

20. An error in computer data is called
   a) Chip
   b) Bug
   c) CPU
   d) Storage device

21. MICR stands for
   a) Magnetic Ink Character Reader
   b) Magnetic Ink Code Reader
   c) Magnetic Ink Cases Reader
   d) None

22. The brain of any computer system is
   a) Control Unit
   b) Arithmetic Logic Unit
   c) Central Processing Unit
   d) Storage Unit

23. To accomplish a task a computer has to process data in three stages. They are:
   a) CU -----> Processing -----> Output
   b) Input -----> ALU -----> Hardware
   c) Hardware -----> CPU -----> Software
   d) Input -----> Processing -----> Output

SPACES FOR ROUGH WORK
24. The central processing unit (CPU) consists of
   a) Input, output and processing
   b) Control unit, primary storage and secondary storage
   c) Control unit, arithmetic-logic unit
   d) Control unit, processing, and primary storage

25. A byte consists of
   a) One bit
   c) Eight bits
   b) Four bits
   d) Sixteen bits

26. The CPU is also known as
   a) The Brain of the computer
   b) The processor
   c) The Central Processing Unit
   d) All of the above

27. Floppy disk is generally named as
   a) a:
   b) b:
   c) c:
   d) d:

28. OCR stands for
   a) Optical Character Recognition
   b) Optical Cache Recognition
   c) Optical character reader
   d) Optical camera recognition

29. PROM stands for
   a) Programmable ROM
   b) Personal ROM
   c) Pre ROM
   d) Post ROM

30. Main function of OMR is
   a) To recognize certain pre-specified types of marks by pen or pencil
   b) Not used for exams
   c) Used for multiple choice questions
   d) Both a and c
31. Microprocessors can be used to make
   a) Computer  
   b) Digital systems  
   c) Calculators  
   d) All of the above

32. The blinking symbol on the computer screen is called the
   a) mouse  
   b) cursor  
   c) hand  
   d) palm

33. The device used to carry digital data on analog lines is called as
   a) Modem  
   b) Multiplexer  
   c) Modulator  
   d) Demodulator

34. A hard copy would be prepared on a
   a) Line printer  
   b) Dot matrix Printer  
   c) Typewriter terminal  
   d) All of the above

35. Binary number system has
   a) 10 digits (0-9)  
   b) 3 digits (-1, 0, 1)  
   c) 1 digit (1)  
   d) digits (0, 1)

36. The octal equivalence of 111010 is
   a) 81  
   b) 72  
   c) 71  
   d) None of these

37. An operating system
   a) helps in checking the spelling of word
   b) maintain the relationship in database
   c) manages the resources of the computer
   d) performs the calculations of cells in Excel

38. Which of the following is an essential file of a MS-DOS boot disk?
   a) COMMAND.COM  
   b) START.COM  
   c) TREE.COM  
   d) VER.COM
39. Command used to copy a file in dos?
   a) cp  b) copy  c) rm  d) copied

40. Full form of MS-DOS is
   a) Micro System Disk Operating System  b) Micro Simple Disk Operating System
   c) Micro Soft Disk Operating System  d) Micro Sort Disk Operating System

41. Which command is used to delete the directory that is empty?
   a) Del*.*  b) Rd  c) Erase  d) Md

42. Which command creates a directory or subdirectory in MS-DOS?
   a) Dir  b) Mkdir  c) Md  d) Both b and c

43. Scanner is the
   a) input device  b) output device
   c) both a and b  d) none of the above

44. The physical equipment which makes up the computer system that we can see and touch is called
   a) software  b) hardware  c) programmer  d) none

45. The part of the CPU where actual data processing occurs i.e., all mathematical calculations and all comparisons is
   a) control unit  b) ALU
   c) Memory storage unit  d) none

46. Temporary fast memory which is placed between the CPU and the main memory is called as
   a) ROM  b) Cache memory
   c) Cash memory  d) Both b and c

47. RAM is also called as
   a) Main memory  b) Secondary memory
   c) Dynamic memory  d) None of above
48. Compiler is a
   a) System software to convert high level program to machine level program
   b) Not a software
   c) Hardware
   d) Operating system

49. Memory which forgets everything when you switch off the power is known as
   a) Corrupted
   b) Volatile
   c) Non-Volatile
   d) Non-Corrupted

50. Which of the following command is used to make multiple changes in a document?
   a) find command
   b) replace command
   c) spelling and grammar
   d) thesaurus

51. Bold, Italic, Regular are known as
   a) font styles
   b) font effects
   c) word art
   d) text effects

52. Italics allows you to emphasize text by
   a) Adding a blinking background
   b) Slanting the text to the left
   c) Placing the text above the baseline
   d) Slanting the text to the right

53. The word wrap features
   a) Automatically move text to the next line when necessary
   b) Allows you to check the spelling mistakes
   c) Allows you to type over text
   d) Is the sort horizontal line indicating the end of document

54. The feature supported by many word processors that enables to do mass mailing is
   a) Mailings
   b) Letter and mailings
   c) Mail merging
   d) Email
55. In a spreadsheet the Intersection of a row and a column is called as
   a) Cell pointer  b) Cell address  c) Cell  d) Active cell

56. On an excel sheet the active cell is indicated by
   a) A dark wide border  b) A dotted border  c) A blinking border  d) None of above

57. The advantage of using a spreadsheet is
   a) calculations can be done automatically  
   b) changing data automatically updates calculations  
   c) more flexibility  d) all of the above

58. There are three types of data found in a spreadsheet
   a) data, words, numbers  b) equations, data, numbers  
   c) words, numbers, labels  d) numbers formulas, labels

59. Which of the following is not an option in the spelling dialog box ?
   a) Edit  b) Ignore  c) Ignore all  d) Change

60. Which types of charts can excel produce ?
   a) Line graphs and pie charts only  b) Only line graphs  
   c) Bar charts, line graphs and pie charts  d) Bar charts and line graphs only

61. How are data organized in a spreadsheet ?
   a) Lines and spaces  b) Layers and planes  
   c) Rows and columns  d) Height and width

62. The cell reference for a range of cells that starts in cell B1 and goes over to column G and down to row 10 is
   a) G1-G10  b) B1.G10  c) B1;G10  d) B1:G10
63. You can use the horizontal and vertical scroll bars to
   a) Split a worksheet into two panes
   b) View different rows and columns
   c) Edit the contents of a cell
   d) View different worksheets

64. In a worksheet you can select
   a) The entire worksheet
   b) Rows
   c) Columns
   d) a, b, and c

65. Rounding errors can occur
   a) When you use multiplication, division or exponentiation in a formula
   b) When you use addition and subtraction in a formula
   c) Because Excel uses hidden decimal places in computation
   d) When you show the results of formulas with different decimal places than the calculated results

66. Special effects used to introduce slides in a presentation are called
   a) effects
   b) custom animations
   c) transitions
   d) present animations

67. From which menu you can access Picture, Text Box, Chart etc?
   a) File
   b) Edit
   c) Insert
   d) View

68. PowerPoint presentation is a collection of
   a) Slides and Handouts
   b) Speaker's notes
   c) Outlines
   d) All of the above

69. How can the slide show be repeated continuously?
   a) loop continuously until 'Esc'
   b) repeat continuously
   c) loop more
   d) none of the above

70. Slides can have
   a) title, text, graphs
   b) drawn objects, shapes
   c) clipart, drawn art, visual
   d) any of the above
71. A Chart can be put as a part of the presentation using  
   a) Insert -> Pictures -> Chart  
   b) Insert -> Chart  
   c) Edit -> Chart  
   d) View -> Chart

72. What is the File Extension of ms-powerpoint document prior to MS-office 2003?  
   a) pdf  
   b) doc  
   c) ppt  
   d) txt

73. Algorithm help us to  
   a) Know the memory capacity  
   b) Identify the base of a number system  
   c) Direct the output to a printer  
   d) Specify the problem completely and clearly

74. The symbol shown in the Figure in flow chart represents
   a) Input  
   c) Decision 
   b) Output  
   d) Termination

75. BASIC stands for  
   a) Basic All purpose Symbolic Instruction Code  
   b) Beginners Assembly Symbolic Instruction Code 
   c) Basic All Standards in COBOL  
   d) Beginners All-purpose Symbolic Instruction Code

76. The basic operations performed by a computer are  
   a) Arithmetic operation  
   b) Logical operation  
   c) Relational operation  
   d) All the above
77. LET statement is
   a) Optional statement  
   b) Assigning statement  
   c) Used for expression assignment  
   d) All of the above

78. BASIC program contains some built in functions which is called as
   a) Matrix operations  
   b) Loops  
   c) Statements  
   d) Library functions

79. In BASIC loops are used to do an action
   a) for a single time  
   b) for multiple times  
   c) alternatively  
   d) none of these

80. The command used in a program to continue a loop until a specified expression is false is
   a) DO....LOOP  
   b) FOR....NEXT  
   c) IF....GOTO  
   d) WHILE....WEND

81. What is the full form of HTTP?
   a) Hyper text transfer protocol  
   b) Hyper text transfer package  
   c) Hyphenation text test program  
   d) None of the above

82. DTP stands for
   a) data transmission procedure  
   b) data typing procedure  
   c) desktop publishing  
   d) disk transfer process

83. WORM stands for
   a) Write once read memory  
   b) Write or read memory  
   c) Write only read many  
   d) None

84. DBMS stands for
   a) Database Management System  
   b) Database Manufacturing System  
   c) Distributed Management System  
   d) Both b and c

SPACE FOR ROUGH WORK
85. TROJAN horse is an example for
   a) Virus
   b) Antivirus
   c) Memory
   d) None of these

86. A self replicating program is
   a) Bug
   b) Virus
   c) Lice
   d) Antivirus

87. LAN stands for
   a) Local area networks
   b) Local access networks
   c) Language area networks
   d) None of the above

88. What is expansion of WWW ?
   a) World wide work
   b) World wide web
   c) Word wide news papers
   d) None of the above

89. A collection of interconnect networks is called an inter network or
   a) Internet
   b) WAN
   c) LAN
   d) MAN

90. Who built the first mechanical calculator ?
   a) Joseph Marie Jacquard
   b) John Mauchly
   c) Blaise Pascal
   d) Howard Aiken

91. In which of the following device user cannot erase or modify the data ?
   a) Floppy disk
   b) Hard disk
   c) Pen drive
   d) CD-ROM

92. The instructions for starting the computer are house on
   a) Random access memory
   b) CD-ROM
   c) Read only memory chip
   d) All of above

93. BASIC language has its own set of words such as
   REM, INPUT, PRINT, LET, READ, DATA, END etc., known as
   a) Shortcuts
   b) Short form
   c) Keywords
   d) Information

---

SPACE FOR ROUGH WORK
94. The statement in BASIC program which halts the execution of a program and it is a last statement where each program should have this statement is
   a) PRINT USING statement
   b) END statement
   c) RESTORE statement
   d) DATA statement

95. IP stands for
   a) Internet process
   b) Internal process
   c) Internal protocol
   d) Internet protocol

96. What is a search engine?
   a) a program that searches engines
   b) a web site that searches anything
   c) a hardware component
   d) a machinery engine that search data

97. What is the full form of TCP/IP?
   a) Transmission control protocol/internet protocol
   b) Telephone call protocol/international protocol
   c) Transport control protocol/internet protocol
   d) None of the above

98. Saving a file from the Internet onto your computer is called
   a) downloading
   b) uploading
   c) transferring
   d) storing

99. A file which contains readymade styles that can be used for a presentation is called
   a) AutoStyle
   b) Template
   c) Wizard
   d) Pre formatting

100. Binary Multiplication of decimal 15 x 5 is
   a) 1001011
   b) 1101011
   c) 1111011
   d) 1000100

SPACE FOR ROUGH WORK